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The TechEthos Project

Short project summary

TechEthos is an EU-funded project that deals with the ethics of the new and emerging technologies
anticipated to have high socio-economic impact. The project involves ten scientific partners and six
science engagement organisations and runs from January 2021 to the end of 2023.

TechEthos aims to Facilitate “ethics by design”, namely, to bring ethical and societal values into the
design and development of new and emerging technologies from the very beginning of the process.
The project will produce operational ethics guidelines for three to four technologies for users such as
researchers, research ethics committees and policy makers. To reconcile the needs of research and
innovation and the concerns of society, the project will explore the awareness, acceptance and
aspirations of academia, industry and the general public alike and reflect them in the guidelines.

TechEthos receives funding from the EU H2020 research and innovation programme under Grant
Agreement No 101006249. This deliverable and its contents reflect only the authors' view. The
Research Executive Agency and the European Commission are not responsible for any use that may be
made of the information contained herein.
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Executive Summary

TechEthos aims to shine a spotlight on ethics within the sphere of technology innovation. In particular,
it targets new and emerging technologies which raise complex ethical issues and are expected to have
significant impacts on the economy and society within a five-to-ten-year horizon. With outputs and
activities aimed at audiences from academia, industry and the general public alike, it needed a
professional yet friendly look.

This deliverable presents a cornerstone of Work Package 7’s (WP7): Dissemination, exploitation and
communication. It highlights the processes put in place under in Task 7.2: Implement communication
and dissemination activities at the inception of the project to build a series of communication and
dissemination tools that would come to provide the project with a strong brand identity both in print
and online. This includes:

o The project’s visual identity, composed of the project’s logo, typography, colour palette
and branding guidelines;

o The project website, the main window of the project for external audiences and a
central place where the main outcomes of the project will be displayed;

o Two social media accounts, LinkedIn and Twitter, set up to act as a real time narrator of
the project; and

o Marketing materials, for print and online use, to help with the communication and
dissemination of the project.

While led primarily by partner Ecsite - The European Network of Science Engagement Organisations,
the work described in this Deliverable benefitted from the close collaboration of the Project
Coordinator (PC) AIT Austrian Institute of Technology (AIT) and WP7 lead Trilateral Research (TRI), as
well as inputs from all partners in a participatory process. The work with the graphic design providers
included many iterations to accommodate the preferences that emerged among partners.

Finally, as the TechEthos project’s work advances, so will its communication and dissemination needs
evolve, and WP7 will further build upon and grow these tools, starting with the strong basis described
in this deliverable. In a first instance, once the three to four technologies or families of technologies
that the project will focus on are known, the website will expand with new sections to reflect new
information, and a project one-page flyer will be developed.

“ e O “ o O
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1. Introduction

In January 2021, TechEthos kicked off an ambitious three-year timeframe with the clear objective to
facilitate “ethics by design”, namely, to bring ethical and societal values into the design and
development of new and emerging technologies from conception to implementation. With outputs
and activities aimed at research and innovation in both academia and industry settings, research ethics
bodies, policy makers and the general public alike, it needed a professional yet friendly look, appealing
to this wide range of audiences.

This deliverable presents a cornerstone of Work Package 7’s (WP7): Dissemination, exploitation and
communication highlighting the processes put in place under in Task 7.2: Implement communication
and dissemination activities at the inception of the project to build a series of communication and
dissemination tools that would come to provide the project with a strong brand identity, both in print
and online.

While Deliverable 7.1 (D7.1) is listed in the DoA as taking the form of ‘websites, patents, fillings’, this
deliverable in the form of a report was produced additionally to act as a repository outlining these
outputs, the processes taken to produce them, and the next steps Ecsite will take to complement and
add to the promotional materials already made so far, responding to the evolving needs of the
project.

The document begins by outlining the process and rationale for the selection of the design services
provider in Section 2. Sections 3, 4, 5 and 6 present the process and final outputs for four types of
materials respectively: the visual identity, the project website, social media accounts, and marketing
materials.

2. Selection of provider

Ecsite kicked of this process namely by first interacting with the consortium during the first WP7
meeting held online on 9 February 2021. Ecsite, with the support of TRI, coordinated an online activity
for partners to provide key messages they think should be communicated to target stakeholders and
information on website features partners liked or disliked.

This kind of information and feedback was invaluable and acted as the backbone to the Open Call for
Tenders that Ecsite published on 15 February, following its internal procurement procedures. All
partners were encouraged to share this Open Call within their network and pass on the call to any past
providers with whom they had had a positive working experience.

The call outlined key information on the budget (€15,000), timing (deadline of 8 March 2021), and
needs of the project:

o A complete graphicidentity pack — logos, fonts, styles guidelines, PowerPoint presentation
template, Word template, an e-newsletter template, project factsheet, and social media
templates; and

o A fully designed website using CMS WordPress or another website building platform.

“ e O “ o O
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A total of 12 providers applied to the call. In collaboration with TRI as WP7 lead and AIT as project
coordinator, Ecsite chose its contractor as Xurris&CO S.C.P., represented by Carla Ariza and Mar
Porgimon (Roger de Lluria 130, 3° 4°,08037. Barcelona, Spain).

3. Visual identity

3.1 Process

In the early stages of collaboration with Xurris & Co, several meetings took place to provide them with
the key information to work with in producing TechEthos' visual identity, such as the project goals,
core values and themes; the origins of the TechEthos project title; target groups; and examples of past
identities that were appealing to project partners.

The process of defining a logo included two rounds of proposals, based on partner feedback during a
WP7 meeting (22 March 2021) and results from a consortium-wide survey (31 March-5 April 2021). The
decision was taken with the project coordinator AIT and TRI (6 April 2021). Further iterations included
the refinement of the shades of blue and red, to arrive at the elements described in Section 3.2.

3.2 Final logo and typography

The final logo can be seen in Figure 1.

TECH=TROS

FUTURE 0 TECHNOLOGY © ETHICS

FC1448 m 00003A

Ubuntu
O O <4 = Ubuntu @, o O

Ubuntu

Figure 1 The TechEthos final logo design in original, grayscale, with colour palette and design
elements

o N o - O
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Logo. The idea behind it is to remove the dichotomy often seen in the research and innovation
community between technology and ethics and create a look that joins these two concepts together
using the triple-line icon. This versatile symbol has two strong connections: the sign in Mathematics to
denote “if and only if” (i.e. meaning technology should be possible if and only if there is ethics) and the
digital world, as it resembles the ‘hamburger’ navigation icon (i.e. TechEthos' role in navigating the
ethical challenges of emerging technologies). This provides a strong message to the field TechEthos is
working in, allowing TechEthos to be not only recognisable but also focussed in the direction the
project will be moving towards.

Font. The font “Ubuntu” was selected as the typeface due to its simplicity and strong, distinguished
look, allowing us to easily create hierarchy in text and documents.

Design elements. Moreover, several star and circle icons and bars icons were developed to add an
extra touch to document templates and the web design.

Colours. A strong preference had emerged among partners on the use of blue, considering the
professional audiences of the project. The fuchsia softens the intensity of the blue, adding a touch of
originality.

Tagline. ‘Future. Technology. Ethics.’ had gathered unanimity among partners since the proposal
stage as a strong statement of the key elements behind TechEthos.

Overall, the clean, professional feel of the logo and font has professional audiences in mind, while the
quirky E symbol and design symbols add versatility for social media and web design.

4. Website

4.1 Process

Ecsite secured the domain www.techethos.eu in the early stages of the project from
www.domain.com, and this is now hosted on Ecsite’s server.

In line with plans to have the website live at M3 (March 20121), but given the iterations necessary to
develop a visual identity that suited the project, www.techethos.eu was brought online with key
information about the project on 19 April 2021. Visitors were also invited to subscribe to our
newsletter. The page was later updated to feature a project presentation for those looking for more
information.

Partners gave feedback on their organisation’s profile and contact details, the presentation of project
activities and contribution to the project’s ‘Glossary of Terms' (9-19 April 2021), and the overall look
and feel, design elements that organise the space and text and visual content across the website’s
main sections (18-20 May 2021). All other design decisions were taken in collaboration with WP7 lead
TRI and the project coordinator AIT. The website with its Full web functionalities went live on 11 June
2021 and was debugged and finalised by the end of June 2021.

‘There are even some little details that prove that it's not just “another
Wordpress” website. [...] The design choice is very consistently and logically
used over the website.’

Communication Officer of partner organisation commenting on the overall design

)
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4.2 Homepage design

A series of initial plans was prepared by Ecsite for Xurris & Co, outlining our desires and structure for
the website. The final design was chosen for its strong visual character and uncluttered feel. A grid
composition that enhances usability in terms of dividing different pieces of content within blocks,
whilst also incorporating key functionalities for each section is at the heart of the homepage (Figure
2).

Header with logo, and a series of
banner images and taglines to

O | capture the main ideas behind the
project.

o | Project website filtering system

Quick actions buttons to take users
to key project information

Latest from us, including
O | news/events in a tile format

Let's keep in touch - o = J
Subzaoribe For news sbowt our work and rezowrce:

Pe® o | Let'skeepintouch’block

o | Website menu breakdown

EU disclaimer

Figure 2 TechEthos homepage outlining grid separation

4.3 Sitemap

The website has been organised into six key sections that allow the users to easily navigate between
their content of interest (see Table 2).

Table 2 Sitemap and content of TechEthos website

Navigation header | Sub-page Purpose

Introducing the project: the challenge it addresses, the

Proj . . . .
About Project project vision and approach, and the funding source.

(1] (1] O (1] o0 O
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Navigation header | Sub-page Purpose
Introducing all partners involved, including main contact
Partners .
E—— point.
Board Introducing the Advisory and Impact Board and their role.
E— Board members will be featured.
Svnerdies Highlighting the projects TechEthos will work closely

with.

Providing information on the TechEthos timeline, what
the project is working on currently, and what the project
Activities - will work on in the future. In the future, specific activities
could have dedicated sub-pages nested under this header
e.g. societal engagement activities, final conference.

Proving an overview of the new and emerging
technologies the project is working on. Subpages
dedicated to each technology or technology family have
been designed and will feature here, giving the user
specific information on ethical implications, guidelines,
recommendations and reports.

Technology corner -

Serving as a repository of downloadable project materials:

Resources ) deliverables, reports, case studies (all in PDF format).

Featuring news articles and events organised by or

N E . . . . .
News & Events involving contributions from TechEthos and its partners.

News and Media Providing media and journalists access to content for

Media communication purposes e.g. press releases, images and
media contact information.

Contact - Contact information for the project.

4.4 Features

As mentioned the website has been built around a block design to increase legibility of the website’s
contents. A number of features enhance the user experience and make it stand out within the EU-
project space. A selection of these are provided in Figure 7.

“ e O “ o O
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Accordion design

Project wide Filtering system

What's here for you

Colour-coded overview of activities

Technology horizon

Past research & results

Glossary of Terms

Technologies whose development and application

are not completely realised or finished, and g spec

whose potential lies in the future. [_] e field

ical and so
benefits of new and emerging technologies it is essential to pr
systems.

Figure 3 A selection of website features

O oo oo

D7.1

An accordion design has been
used throughout the website
where pages are at risk of being
text heavy. The accordion feature
allows users to close large
sections of text when the sections
are no longer needed. It also
provides instant structure. The
example featured is from the
‘About -> Partners’ page.

A filtering system is used on the
home and the ‘Resources’ pages,
to provide a tailored experience
for users when accessing the
website. Visitors can filter based
on two characteristics: type of
content (e.g. “interview”, “report”)
and topic (e.g. “ethical issues”,
specific technologies. This allows
users who might have an interest
only in a specific technology to
find that content directly.

A colour coding system has been
utilised for the Activities page
allowing users to quickly become
aware of what has already
happened in the project, what is
currently being worked on and
what is still to come.

Visitors will encounter definitions
of key terms related to the project
on the website pages and a full
Glossary of Terms.

x*x
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4.5 Privacy and accessibility

Privacy Policy. The notice indicates the purposes, requirements and restrictions in the processing of
personal data of users who submit information to the TechEthos project and presents our
commitments to user privacy and data protection.

Cookie Policy. Based on existing practice, including the websites of the European Commission, the
website offers visitors three options: ‘Accept all cookies, Accept selected cookies, Accept only
essential cookies’. Moreover, our cookie policy explains how cookies work, the cookies that are being
used on the project website and how the user can customise cookies further from their own browser.

Accessibility.

The website provides alternative text for all images and linked images, ensures all text is aligned left
for improved readability for individuals with visual impairment and lays out the right hierarchies for
headings and navigation features for smooth navigation.

All website content is available under a Creative Commons Attribution 4.0 International

License allowing any user to share (i.e., copy and redistribute the material in any medium or format) or
adapt (remix, transform, and build upon the material for any purpose, even commercially, under the
following terms: the user must give appropriate credit, provide a link to the license, and indicate if
changes were made. A user may do so in any reasonable manner, but not in any way that suggests the
licensor endorses the user or their use; and may not apply legal terms or technological measures that
legally restrict others from doing anything the license permits.

5. Promotional materials

5.1 Process

A series of other promotional materials applying the visual identity presented in Section 3 were
designed by Xurris & Co.: the project’'s Word and PowerPoint template, e-newsletter template and
social media templates. Section 5.2 presents, one by one, our initial requirements for these materials
and the final products delivered. All the materials referred to in this section have been communicated
to partners via email and are available to be consulted and downloaded on the project’s shared drive.

During the development, feedback on these materials was obtained from the project coordinator AIT
and the WP7 lead TRI.

5.2 Materials produced

5.2.1 Word template

An editable deliverable template (in .dotx file format) was prepared, keeping in mind the specific
needs of EU-funded project deliverables (e.g. EU flag, funding and responsibility disclaimers). The main
components and design elements are presented in Table 3. Furthermore, this was further simplified
forinternal use into a ‘general document’ template. Moreover, a guidance document on how to use
the Word template was developed together with AIT and TRI in the process of Quality Assurance (see
Annex 2).

o N o S O
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Table 3 Main components and design elements of the TechEthos Deliverable Template

Cover page

List of Tables and List of

Figures, Definitions and
abbreviations, etc.

Short project summary
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Project Information
e pgssranrmoer | 1010029
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Topi impact
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Dissemination Level
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The TechEthos Project

Short project summary

science engagement organisations and runs from January 2021 ko the end of 2023.
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Partners can choose between a
cover page with or without a
cover photo, as best fits their
purpose.

Sections

oxx
1. Introduction
Highlight text: At vel magna feugait corpora. Purto dignissim at eum, cum in posse

intellegam, est ut enim falliimperdiet. An quas solum, solek omnium integre cum
eu. Vel gubergren prodesset ea. Alia vidisse at per, no est option epicuri.

Body text: intellegam, est ut enim
fall imperciet. Vel gubergren
prodesset ea. Alia vicisse ak per, o est option epicuri.

"Quote: At vel magna feugait corpora. Purto dignissim at
intell £ ut enim i t

integre cum ev.”

fuotesatror.

At vel magna feugait corpora. Purto dignissim &t eurn, cun n posse intellegam, est ut erim fall
imperdiet i fumi

1.1 Heading 2

At vel magna feugait corpora. Purto dignissim at eum, cumin posseintellegam, est ut enim fall
imperdiet. el

e,

cumin posse

eell & ut enim falli mperdiet. An

111 Heading 3
Atvel

imperdiet
‘5. Als vidisse at per, no est option epicuri
Exarmple bullet points:

o Atvel magns feugait corpor.

o Purto dignissim at eum, cum in posse intellegam, est ut enim fali imperdiet.

Alie vidisse at per, no est option epicuri.

A set of pre-defined sections
helps partners input the official
and technical details (e.g.
dissemination level) of their
deliverable as well as aspects such
as keywords and the preferred
citation.

’ Back cover

e
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coordinated by %
AT o
Partners
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LLinked Third Parties *
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(¥) @TechEthosey  (in) TechEthosEu

www_techethos.eu Info@tachethos.eu

Pre-defined text describing the
project. The page also features all
the partner logos.

Colour theme

Theme colors Sample

Text/Background - Dark 1
- g Text Text

o S5
+ih. B

Hyperink

Text/Background - Light 1
Text/Background - Dark 2
Text/Background - Light 2

Accent 1

Accent 2
Accent 3
Accent 4
Accent 5
Accent §

Hyperlink

EEEEECNEEECE

Eollowed Hyperlink

)

N\
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D7.1

All deliverables are expected to
feature: Executive Summary,
Introduction, Conclusion and
Future outlook, References,

Annexes. An attractive back cover featuring

the project logo, project partner

A number of pre-defined colours
saved as a colour theme allows
partners to generate and
customise their SmartArt and

Further sections from 2. onwards

logos and social media handles.

by using the heading style
‘Heading 1'. Further hierarchies
inside each section using the
styles ‘Heading 2’ and ‘Heading 3’

other design elements in line with
the visual identity of the project.

5.2.2 PowerPoint template

An editable presentation template (in .potx file format) was prepared, keeping in mind the specific
needs of the project. The main slide designs elements are presented in Table 4. Moreover, a number of
pre-defined colours saved as a colour theme allows partners to generate and customise their SmartArt
and other design elements in line with the visual identity of the project. This and other possible
questions are taken up in a guidance document, developed with feedback from TRI (see Annex 3).
Finally, the designers provided two explanatory videos on how to insert and adjust an image, and how

to edit the back cover of the slides.

Table 4 Examples of slide designs available in the PowerPoint template

Visual

TECH=THOS

FUTURE © TECHNOLOGY 0 ETHICS

TECH=THOS

e
‘

Presentation title

Speaker, Organisation...
(More options For the main title slide are available via ‘New

‘ Description

Front cover

Title pages. Four options are available: displaying
the full 16 logos or only the main 10 partner logos
(the Full logos, which include Linked Third Parties,
should be used when they have been involved in
the Work Package or Task that is the subject of the

Slide”)
AT B s B e e e presentation or when the presentation refers to
[ i L. -l S TUDelft  gFTwENTE . . . . .
- e b e L their work); with or without a picture, according to
partners’ needs.
I e dnder o ongrecment M 147008348 Te2#2r"
(1] [ 1] O L L) o0 O
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Visual

o

Main title

Heading text

Body text

(More options of content slides
with images are available via
‘New slide’)

TECH=THOS

Insert image

D7.1

‘ Description

Main template slides.

Partners can choose to focus on content or on
images, with 10 different slide designs available.

Use this slide to

Or delete it if you don’t need

TECH=THOS

make a timeline

it

Lorem ipsum | 2 | Lorem ipsum

Lorem ipsum

| Text i | Text

Timelines slide to highlight a process or an action
plan.

Text Text

TECH=THOS

Use this slide to make a table

Or delete it if you don’t need it

Table slide.

TECH=THOS

Use this slide to present your team

Insert image Insert image Insert image
Name Name
Position _Position
- [Shot deseiptive text
40 E-mail address =4
i i @Twitter user ®
@ | Linkedin user ! @ ! Linkedin_user @ Linkedin_user

o [ R ——

Team slide where partners can highlight project
team members.

m L L) o0

N\
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Visual ‘ Description

TECH=THOS'

FUTURE © TECHNOLOGY 0 ETHICS
. ‘ Back cover.

Thanks, Farewells...

4 Mobile o telephane | © Location 154 e-mail adress T3] website

5.2.3 Newsletter template

The needs identified for the newsletter campaign template were: a main banner section including
TechEthos logo, vertical and horizontal sections for articles, a panel for a quote, share buttons for
social media, and dedicated sections where partners’ logos and the EU flag, and the funding and
responsibility disclaimer could be featured (see Table 5). The newsletter design was created directly in
the emailing platform chosen for the project needs, Moosend (www.moosend.com).

Table 5 Overview of the TechEthos newsletter sections

Visual Description

Mo images? Click here

T E C H T H O 8 Top banner featuring the project logo

FUTURE = TEC ETHCS

Welcome to Techethos

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam.

Euismod tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad minim veniam, We lCO me se Ct| on
quis nostrud exerci tation ullamcorper suscipit lobortis nisl ut aliquip ex ea commode.

See Website

“ e O “ o O
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Visual Description

Title

Lorem ipsum dolor sit amet,
consectetuer adipiscing elit, sed
diam. . . .
Main article, horizontal layout
Eulsmod tincidunt ut laoreet dolore magna
aliguam erat volutpat. Ut wisi enim ad minim
wvenlam, quis nostrud exercl tation ullameorper
suscipit lobortis nisl ut aliquip ex ea commoda.

Read now

Secondary articles, vertical layout

Title Title

Lorem ipsum dolor sit amet, Lorem ipsum dolor sit amet,
consectetuer adipiscing elit, sed consectetuer adipiscing elit, sed
diam. diam.

Euismod tincidunt ut laoreet dolore magna
aliguam erat volutpat. Ut wisi enim ad minim
veniam, quis nostrud exerci tation
ullamcorper suscipit lobortis nisl ut aliquip
ex ea commada.

Euismaod tincidunt ut laoreet dolore magna
aliquam erat volutpat. Ut wisi enim ad minim
veniam, quis nostrud exerci tation
ullamcorper suscipit labortis nisl ut aliquip
ex ea commado.

Further reads and talks

Media, pdf, document, tool...

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam. Resources, horizontal layout

Euismod tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad minim
veniam, quis nostrud exerci tation ullamcorper suscipit lobortis nisl ut aliquip ex ea commodo.

o o O . e O
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Visual Description

Media, pdFf, document, tool Media, pdFf, document, tool

Lorem ipsum dolor sit amet, Lorem ipsum dolor sit amet,

consectetuer adipiscing elit, sed consectetuer adipiscing elit, sed

diam. diam. .
Resources, vertical layout

Euismod tincidunt ut laoreet dolore Euismod tincidunt ut laoreet dolore

magna aliguam erat volutpat. Ut wisi magna aliguam erat volutpat. Uk wisi

enim ad minim veniam, quis nostrud enim ad minim veniam, quis nostrud

exerci tation ullamcorper suscipit exerci tation ullamcorper suscipit

lobortis nisl ut aliquip ex ea commodo. lobortis nisl ut aliquip ex ea commodo.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit,
sed diam nonummy nibh euismod tincidunt ut laoreet dolore

magna aliquam erat volutpat” Quote

Keep in touch with us

Contact and social media

AITM‘E "':: a”ea E & s

el € mm>  Tupem  UMMERSY Partner logos
- T m LANDIA _% - m.fnnc-mﬁ "-\*‘.-fh"

TechEthes project consertium under EC grant agreement 101006249 and do not

necessarily reflect the views of the European Commission, The European Commission EU Flag' Funding and responsibility disclaimer

- The information, documentation and figures in this newsletter were produced by the
is not liable For any use that may be made of the information contained herein.

This newsletter was authored by xx. Newsletter coordination and distribution by Ecsite. The TechEthos project is

coordinated by AIT - Austrian Institute of Technology. Fin a l Secti on

You are receiving this email because you opted in via our website.
Our mailing address is: TechEthos, Av Louise 89/7 Floor, Brussels 1050, Belgium.

Add us to your address book.
Want to change how you receive these emails?

You can update your preferencesor unsubscribe from this list.

“ o O “ e O
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5.2.4 Social media templates

The project needed editable social media templates that could allow us to achieve a coherent visual
look on the project’s Twitter and LinkedIn accounts, accommodating for the use of both pictures and

text. Exceeding our initial expectations, Xurris & Co. proposed four iterations of the editable social
media template, suitable for different purposes:

o Event post —This template is suitable for social media posts highlighting an upcoming
event. It utilizes the colours of TechEthos as filters overlaying project images, creating
a strong visual identity (see Figure 4).

-

Pl = /TECH THOS

Title Event

Title Event Lorem ipsum dolor sit amat,
Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed 2 & !

. diam nonummy nibh euis diam nonummy nibh eut
1 dolor sit amet,

Monday | 23-April | 10 AM

-
\

Monday 23-April 10 AM

=

TECH THOS ™

: . /TECH THOS

1 E
A g
-
Title Event
Lorem ipsum dolor sit amet,
consectetuer adipiscing elit, sed
diam nonummy nibh euis.

Title Event

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed
diam nonummy nibh euismod tincidunt ut lacreet dolore magna
= . aliquam erat volutpat.

uis.

Monday 23-April 10 AM
g -

e

Monday | 23-April | 10 AM

Figure 4 Social media template for event posts

o Statement post - This design highlights a statement to capture attention (see Figure
5)

TECHZTHOS + VEER IOk

. +
+ -

Lorem ipsum dolor sit Lorem ipsum dolor sit
amet, consectetuert amet, consectetuert

i
i

Figure 5 Social media template for statements

o - o S O
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o Quote post - post template highlighting a quote from a news article/event (see Figure

6)
TECH=THOS -4 TECH THOS
@

#f Lorem ipsum dolor sit amet, consectetuer Lorem !psurn_ dolor s!t amet, consect_etuer
adipiscing elit, sed diam nonummy nibh adipiscing elit, sed diam nonummy nibh
euismod tincidunt ut laoreet dolore magna ° euismod tincidunt ut laoreet dolore magna
aliquam erat volutpat. aliquam erat volutpat.

Author’s quote Author’s quote
+ Credit Source L Credit Source

TECH THOS

R

Lorem ipsum dolor sit amet, consectetuer
adipiscing elit, sed diam nonummy nibh
euismod tincidunt ut laoreet dolore magna °
aliquam erat volutpat.

Author’s quote

Credit Source

Figure 6 Social media template for quotes

o Text post—template to share longer pieces of text using hierarchical headings (see Figure 7)

TECH=THOS -+ TECH-THOS
| + p
e 5

1
Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam
nonummy nibh euismod tincidunt ut laoreet dolore. nonummy nibh euismod tincidunt ut laoreet dolore.
Lerem ipsum delor sit amet, consectetuer adipiscing elit, sed diam nonummy Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam nonummy
nibh evismod tincidunt ut lacreet dolore. nibh euismod tincidunt ut laoreet dolore.

TECH THOS

pY

_ Welcome to Techethos

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam

nonummy nibh euismod tincidunt ut laoreet dolore.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam nonummy
nibh euismod tincidunt ut laoreet dolore.

Figure 7 Social media template for longer text

These templates have already been put into practice both on Twitter and LinkedIn (see Figure 8 for an
illustration).

“ O . e O
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= TechEthos
= @TechithosEU = g;:f;;fosw

How do we ensure #Artificiallntelligence is used for Join @nesta_uk to explore new worlds through online

societal good? As the ”Europe_a_n Commission’s digital scenario building techniques to help create collective

chief, @vestager said "On artificial intelligence, trust is a visions for the futures. Futures that that will include

must, not a nice-to-have.” #BigData & other emerging #Al agents §~

@hilarysutcliffe's article on @Medium delves deeper Register for a free pass nesta.org.uk/event/winning-

hilary-4230.medium.com/if-trust-is-a-...

TECH THOS

&

It is not only the technologies which need
to be seen as trustworthy, the system

Event by nesta

How can we engage people

to imagine - and create - more
sustainable and inclusive Futures?
Join nesta to create visions for a future
that includes big data and other emerging
Al agaents.

of governance itself, and the regulators
applying it, need also to earn public trust.

Hilary Sutcliffe

Medium publication

Wednesday 16 June 17:00

Figure 8 Social media templates for quotes and events in use

6. Social media channels

The TechEthos Twitter account and LinkedIn company page were set up on 29 March 2021, in line with
the Milestone of M3 (March 2021). This launch coincided with the visual identity, as social media
design elements were produced to fit each platform’s design (Figure 9). Notably, the three-line “E”
icon is used as the profile picture and the logo with the tagline is used as the banner image.

Ecsite is currently working towards connecting with followers and mapping interesting users, projects
and companies to contact directly to form relationships. For further details of the social media
strategy please refer to D7.2 — Communication and Dissemination Plan.

-
|

JUS S B

FUTURE = TECHNOLOGY @ ETHICS

— [ Edit profile |
TechEthos
@TechEthosEU
Figure 9 The TechEthos design elements for social media
(1] [ 1] O L L) o0 O
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7. Conclusions and fFuture outlook

Over the first six months of the project, a number of key outputs have been developed for TechEthos.
A strong visual identity (composed of the project’s logo, typography, colour palette and branding
guidelines) is at the core of TechEthos’ branding look. The project website (www.techethos.eu) acts as
the main window of the project onto the world, a central place where the main outcomes will be
displayed and which can grow alongside the project. Two social media accounts have been set up for
the project, LinkedIn and Twitter, to act as a real time narrator of the project. Finally, a range of
marketing materials, answering to both print and online needs, will support the communication and

dissemination of the project.

Over the next few months further work will be implemented, enriching the materials already
produced so far. Some of the upcoming next steps in this process are:

o To add further content to the project website, notably:

o Technology corner: once the 3-4 technologies have been selected in July 2021, this will
feed into the technology corner on the website. As more insights into each specific
technology are produced, each technology will have its dedicated page nested under
the current ‘Technology Corner’.

o Advisory and Impact Board: All board member profiles will be featured on the website
for users to explore further garnering trust between the users and the results of the

project.

o Factsheet

o With the selection of technologies in July 2021, a factsheet that outline the main aims
and focus of the TechEthos project will be designed. This factsheet will feed into the
Media section of the website and be used at events in the early stages of the project.

“ e O “ o O
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8. Annexes

8.1 Annex 1 — Word template guidance document (for partner
use)

E Guidance for using the Word Deliverable Template

Guidance for using the Word Deliverable
Template

1. What do | need to get started?

o Make sure you have the Font Family Ubuntu installed on your computer before proceeding.
You can find the files on the OneDrive or download them yourself by accessing
https://fonts.google.com/specimen/Ubuntu. This will be essential if the Font is to display on
your computer in the Word Deliverable template (as well as in the project’s PowerPoint
presentation template). A step-by-step guide on installation is available here for
Microsoft and here for Mac.

o Download the template TechEthos deliverable template.doxt to your computer. When
opening this file, it will automatically generate a new editable Word (.docx) document for you.
Go to 'Save As’ and save it in your desired location.

o Nameitaccording to the following convention:

o While the document is a work in progress: DX.X_Deliverable Name_VX e.g. D7.1 Visual
identity, project website and social media accounts and marketing materials_V1.

o When sending for Quality Assurance: DX.X_Deliverable Name_QA

o Once the document is complete: DX.X_Deliverable Name_FINAL.

2. What are the basic aspects of the deliverable template?

o Cover page: Choose between a cover page without or with a cover photo. Delete the picture
or replace it {right click -> ‘Change picture’) with a picture relevant for your deliverable, as best
fits your purpose.

o Header: Edit the header on page 1 with the title of your deliverable and the shorthand Dx.x;
this will then display throughout the document.

o Complete the technical details of your deliverable in the predefined tables on pages 1-2
according to the instructions.

3. What sections should be Featured in the deliverable?

The template provides a number of standard sections. The specific content of most of these sections
will, of course, change based on your deliverable. We note below when specific language or material
should be used.

The information, documentation and figures in this deliverable were produced by the TechEthos project consortium
under EC grant agreement 101006249 and do not necessarily reflect the views of the European Commission. The
European Commission is not liable For any use that may be made of the information contained herein.

O oo e O oo oo O
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E Guidance for using the Word Deliverable Template

Section

Short project summary

Guidance

Pre-defined. You do not have to change it.

List of Tables and List of Figures

These can be updated easily if you use the automated way to add
captions to tables and figures throughout the document.

In general, captions may be added by right-clicking on a new table
or figure and selecting ‘Insert Caption...'

See also the answers to ‘How do | add a table?' and 'How do | add a
picture/illustration’.

Definitions and abbreviations

Complete this section based on your specific deliverable.

Executive Summary

Provide a brief summary of your deliverable and its aims.

Sections

All deliverables are expected to feature: Introduction, Conclusion
and fFuture outlook, References, Annexes.

Add Further sections from 2. onwards by using the heading style
‘Heading 1

Add further hierarchies inside each section using the styles
‘Heading 2" and 'Heading 3'

4, What design elements can | use?

The template includes a number of design elements. We recommend that you Copy and Paste the
existing examples in the desired position and fill them with your content. Alternatively, you can use
the Home -> Styles section to select the desired design.

o You can choose to add some highlight text at the start of each section (For example, a short
summary of the section, which could also be used in the Executive Summary).

o You can feature a quotation and its author toillustrate an important point.

o You can divide sections and subsections using the long or short diving lines respectively.

O e
0O i

O . O

o You can add images, tables, and SmartArt.

5. How do | add a table?

o Toinsert a table, Copy the table found in Section 2 and adapt it to your needs, or go to ‘Insert -

>Table'.

O L L) L 1] O
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E Guidance for using the Word Deliverable Template

o The caption should precede the table; add it using: ‘References -> Captions -> Insert Caption ->
Type of caption: Table’ so that it can feature automatically in the List of Tables.
6. How do | add a picture/illustration?

o Toinsert a picture, use the following command: 'Insert -> Image’. We recommend that you
centre the image, in line with text.

o The caption should succeed the image; add it using 'References -> Captions -> Insert Caption ->
Type of caption: Figure’ so that it can feature automatically in the List of Figures.

7. How do | customise SmartArt (like flow charts, lists,
processes, cycles etc.)?

Check First that in Design -> Colors the TechEthos Theme is selected. You will then be proposed
different colour options for SmartArt that are in line with the project’s colours.

A =4 Paragraph Spacing ~ .I . m B . |

|§| Effects =
Fonts Primary Theme Colors
- @ Setas Default P
! | 1 |
Custom -
Colorful
B I Techthos Theme [ ]
Office 1 Il .
- | Accent1
I T off
1= Il NN EE -
HE EE = | 1 |
Il - 1 B |
Check First that in ‘Design -> Colors’ the Select your SmartArt and go to the tab
TechEthos Theme is selected. ‘SmartArt Tools = Change colours’

8. Which spelling should | use?

In line with the European Commission’s own style guide, we recommend that the language, spelling
and punctuation used in your deliverable should be understandable to speakers of Standard British
English {(defined as the standard usage of Britain and Ireland), avoiding both Americanisms and very
colloquial British usage.

9, Which referencing style should | use?

Deliverables should use the Harvard in-text citation and reference list style, as agreed upon by the
consortium.

C L 1) L 1) O L L) L 1) O
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E Guidance for using the Word Deliverable Template

10. Proof-reading checklist for deliverable authors

(Credit: adapted based on a template developed by Dr. Ralf Lindner, Fraunhofer IS| for the
NewHoRRIzon Project.)

Please review this proof-reading checklist to correct for common mistakes beFore submitting your

deliverable For Quality Assurance.

Element

Issue/Common Mistake(s)

The document at hand is the latest version including all revisions and

chapters/continuous numbering without chapter number).

Document file additions: no track changes pending, no further comments. Ready for | O
submission to Quality Assurance

Document file After proofreadlng afld Flr.lallsatlon: the file is named appropriately, 0
as per section 1 of this guidance document

Front Page/Cover | The author names are correctly spelled. O

Table of Contents | There is a table of contents, a table of figures, and a list of tables. O

Table of Contents The table of contents, including page numbers and headings, is 0
updated.

+ableofEorents The tabl§ of contents comprises all relevant headings and 0
subheadings {max. three levels).

Table of The table of figures and the list of tables comprise all figures and

; O

Figures/Tables tables.

Main text All template highlighted text has been deleted O

A FERE Suggestlons of the.automaFlc spelllng and grammar check are 0
reviewed and considered — if appropriate.

Main text The final text (after accepting track changes) has been proofread. O

iRl Headings and subheadings use the same style throughout the text, 0
as specified in the Template and this guidance document.

. Cross references are updated - links from one section of the text to

Main text . . . O
another {(e.q., referencing an appendix) are working.
All tables have meaningful captions and are continuously numbered

Main text (check For inconsistencies regarding numbering along O
chapters/continuous numbering without chapter number).

Main text Tables have the same Formatting (Font, Font size, line spacing, etc.) - 0
if reasonable.
All Figures have meaningful captions and are continuously numbered

Main text (check For inconsistencies regarding numbering along O

)

o,

L 1) L 1) ), L L) L 1)
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E Guidance for using the Word Deliverable Template

SR Flgure captlons. have the same formatting (font, font size, line 0
spacing, etc.) —if reasonable.
Main text Figures do not break across pages —if possible. O
Main text Every reference has an entry in the reference list. O
: Reference check: The name(s) and year of each reference match the
Main kext . . O
reference entry in the reference list.
The style of referencing within the text is consistent:
" y ; O
o Separation of multiple entries: Is there a comma or a
semicolon?
o Separation of name and vear: Is there a comma, a colon, a o
blank space?
o Separation of two authors of the same entry: Is there a O
Main text comma, a slash or an “and"?
o Multiple authors: How is the “et al” formatted {in O
Italic/standard, is there a full stop behind it, etc.)
o Page numbers: Choose between either “p.” and number or 0O
numbers only.
o Page numbers: Is there a comma or colon between the year O
and the page number?
Abbreviated terms are written out the first time they are used,
Main text followed by their abbreviation (in brackets), and added to the listof | O
abbreviations at the start of the document.
Fi tabl d illustrations h. 14 tive text (right click
R igures, _‘3 es and illustrations have an alternative text (right click — O
Format Picture... — Alt Text)
Main text Consistent use of British English — set autocorrect accordingly. O
Main text Consistent gender-neutral language. O
Bullet points are used in the same style throughout the text (e.g.
Main text bullets or dashes, size of the items, etc.), consistent with the O
Template.
Reference list There is a reference list. O
RefranesTice Every entry in the reference list is mentioned/cited in the text at 0
least once.
Reference list The reference list is in alphabetical order. O
All entries in the reference list follow the same Harvard citation
Reference list style. Check aspects such as:

)

L 1) L 1) ), L L) L 1)
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E Guidance for using the Word Deliverable Template

o Format of names: Is the first name written out or O
abbreviated (initials)?
o Title: How are title and subtitle separated (colon, full stop)? O
0 Punctuation: Is there a comma, a semicolon, etc. between the
names of multiple authors? Is there a full stop after every O
entry?
o Typography: Are titles of books, articles, journals, etc.
continuously written in italics or not? o
o Etc.
Ifitis a deliverable based on empirical material: there is a list of
Annexes sources (list of interviews, list of documents analysed, etc.), and, O
where applicable, sufficiently anonymised.
Use the find-and-replace function of your text processing software
to check and correct the following issues:
o The project acronym is correct including the uppercase and 0
lowercase characters.
whole document .
o Remove unnecessary blank characters (e.g., find instances of a
two blank characters by placing two spaces in the “find” field
(" ", excluding the ") and, in the “replace all” field, enter one
space (" “, excluding the *).
Check the use of dates, times, etc. in terms of style: Is it the same
Whole document | throughout the text (e.g. "November 1st 20167, "01/11/2016", O
“06:00h", “6:00h", etc.)?
After having checked the above issues, update the Table of
Final document Contents, List of Tables and List of Figures again (page numbers O
could have changed because of the review process).
Final pdf The PDF document conforms to the original document (same 0
document number of pages, same size).
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8.2 Annex 2 — PowerPoint template guidance document (for
partner use)

E Guidance fFor using the PowerPoint Template

Guidance for using the PowerPoint Template

What do | need to get started?

o Make sure you have the font Family Ubuntu installed on your computer before proceeding. You
can find the files on the OneDrive or download them yourself by accessing
https://fonts.google.com/specimen/Ubuntu. This will be essentialif the font is to display on
your computer in the Powerpoint presentation template. A step-by-step guide on installation
is available here for Microsoft and here for Mac.

o Download the template TechEthos presentation.potx from this OneDrive folder. When
opening this file, it will automatically generate a new editable presentation (.pptx) for you. Go
to 'Save As’ and save it in your desired location.

What kind of slide templates are available for me to use?

In the Home tab, use the function ‘New Slide’ to see all the options available. These are some of the
options you'll find:

o Front cover slide
o Title page, with 4 options to choose from:

o Displaying the full 16 logos or only the main 10 partner logos. We recommend that you
use the full logos, which include Linked Third Parties, when they have been involved in
your Work Package or Task, or when your presentation refers to their work on the
ground.

o With or without a picture, according to your needs.

o Main template slides - you can choose to focus more on content or images, with 10 different
slide designs available

o Table slide - keep the slide with this option, adapting it to your needs, or delete it if not
necessary

o Timeline slide - keep the slide with this option, adapting it to your needs, or delete it if not
necessary

o Teamslide

o Back cover - we foresaw several options for contact details, but the icons are not directly
editable. Should you need something different, watch this video to edit via Master Slides, or
get in touch with us and we will prepare it for you.

The information, documentation and figures in this deliverable were produced by the TechEthos project consortium
under EC grant agreement 101006249 and do not necessarily reflect the views of the European Commission. The
European Commission is not liable for any use that may be made of the information contained herein.
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E Guidance for using the PowerPoint template

| am having trouble with an image |l inserted, it doesn’t look right.
What do | do?

Please watch this video From the designers showing you how to adjust images added with the option
‘Insert Image’.

| want to customise other aspects of my slides. What do | do?

To give any SmartArt you might use a look and feelin line with the visual identity, use a design based
on the official colours of the project.

o Make sure that in ‘Design -> Variants -> Colors’ the TechEthos theme is selected:

1
TECH=THOS

o Select your SmartArt -> SmartArt Tools -> Design -> Change Colours -> Pick an option based on
the TechEthos colours:

‘‘‘‘‘‘

TECH=THOS

-Twr TECHNCLOGY 0 ETHCS

This project has received funding from the European Union’s Horizon 2020 research
and innovation programme under grant agreement No.101006249.
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